# Table of Contents

## Section 1
Introduction ........................................................................................... 1-1  
  1.1 Device Support .........................................................................................1-1

## Section 2
Getting Started...................................................................................... 2-1  
  2.1 Unpacking the System ..............................................................................2-1  
  2.2 System Requirements...............................................................................2-1

## Section 3
Connecting the Hardware ..................................................................... 3-1

## Section 4
Hardware Description ........................................................................... 4-1  
  4.1 Jumpers and Links and their Functions ....................................................4-2  
  4.2 External Connections................................................................................4-2

## Section 5
Installing the Software .......................................................................... 5-1  
  5.1 Windows 95 ..............................................................................................5-1  
  5.2 Windows 3.1 .............................................................................................5-1

## Section 6
How to use the Software....................................................................... 6-1  
  6.1 Projects .....................................................................................................6-1  
  6.2 Files ..........................................................................................................6-1  
  6.3 Editing Data ..............................................................................................6-2  
  6.4 Programming ............................................................................................6-2  
  6.5 Auto-Program ..........................................................................................6-2  
  6.6 New Project...............................................................................................6-3  
  6.7 Open Project .............................................................................................6-3  
  6.8 Save Project...............................................................................................6-3  
  6.9 Load File ...................................................................................................6-3  
  6.10 Save File ..................................................................................................6-3  
  6.11 Exit ..........................................................................................................6-4  
  6.12 Clear Buffer...............................................................................................6-4  
  6.13 Fill Buffer...................................................................................................6-4  
  6.14 Goto .........................................................................................................6-4  
  6.15 Find .........................................................................................................6-4  
  6.16 Device Empty Check.................................................................................6-4
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.17</td>
<td>Program Device</td>
<td>6-4</td>
</tr>
<tr>
<td>6.18</td>
<td>Verify Device</td>
<td>6-5</td>
</tr>
<tr>
<td>6.19</td>
<td>Program EEPROM</td>
<td>6-5</td>
</tr>
<tr>
<td>6.20</td>
<td>Verify EEPROM</td>
<td>6-5</td>
</tr>
<tr>
<td>6.21</td>
<td>Read Device</td>
<td>6-5</td>
</tr>
<tr>
<td>6.22</td>
<td>Read EEPROM</td>
<td>6-6</td>
</tr>
<tr>
<td>6.23</td>
<td>Program Lockbits</td>
<td>6-6</td>
</tr>
<tr>
<td>6.24</td>
<td>Erase Device</td>
<td>6-6</td>
</tr>
<tr>
<td>6.25</td>
<td>Health Check</td>
<td>6-6</td>
</tr>
<tr>
<td>6.26</td>
<td>Printer Port</td>
<td>6-6</td>
</tr>
<tr>
<td>6.27</td>
<td>Font Selection</td>
<td>6-7</td>
</tr>
<tr>
<td>6.28</td>
<td>Advanced Options</td>
<td>6-7</td>
</tr>
<tr>
<td>6.29</td>
<td>Edit as ASCII</td>
<td>6-7</td>
</tr>
<tr>
<td>6.30</td>
<td>Device Checksum</td>
<td>6-7</td>
</tr>
<tr>
<td>6.31</td>
<td>Select Colors</td>
<td>6-7</td>
</tr>
<tr>
<td><strong>Section 7</strong></td>
<td>Device Programming</td>
<td>7-1</td>
</tr>
<tr>
<td>7.1</td>
<td>Device Orientation</td>
<td>7-1</td>
</tr>
<tr>
<td>7.2</td>
<td>Voltage Selection</td>
<td>7-2</td>
</tr>
<tr>
<td>7.3</td>
<td>Power and Lead Connections</td>
<td>7-2</td>
</tr>
<tr>
<td>7.4</td>
<td>Programming 8-Pin Parts</td>
<td>7-2</td>
</tr>
<tr>
<td><strong>Section 8</strong></td>
<td>Brown-Out Detector</td>
<td>8-1</td>
</tr>
<tr>
<td><strong>Section 9</strong></td>
<td>Board Applications</td>
<td>9-1</td>
</tr>
<tr>
<td>9.1</td>
<td>Using Switches and LEDs</td>
<td>9-1</td>
</tr>
<tr>
<td>9.1.1</td>
<td>Using 8-Pin Devices with LEDs</td>
<td>9-1</td>
</tr>
<tr>
<td>9.2</td>
<td>Configuring Switches and LEDs</td>
<td>9-1</td>
</tr>
<tr>
<td>9.3</td>
<td>Using External Connections</td>
<td>9-1</td>
</tr>
<tr>
<td>9.3.1</td>
<td>20-Pin and 40-Pin Digital Sockets</td>
<td>9-2</td>
</tr>
<tr>
<td>9.3.2</td>
<td>40-Pin A/D Socket</td>
<td>9-2</td>
</tr>
<tr>
<td>9.3.3</td>
<td>28-Pin Socket</td>
<td>9-2</td>
</tr>
<tr>
<td>9.3.4</td>
<td>8-Pin Socket</td>
<td>9-3</td>
</tr>
<tr>
<td>9.3.5</td>
<td>Misc. Header</td>
<td>9-3</td>
</tr>
<tr>
<td>9.3.6</td>
<td>All Sockets</td>
<td>9-3</td>
</tr>
<tr>
<td>9.4</td>
<td>Using Analog Parts</td>
<td>9-3</td>
</tr>
<tr>
<td>9.4.1</td>
<td>Using Internal Reference</td>
<td>9-4</td>
</tr>
<tr>
<td>9.4.2</td>
<td>Using External Reference</td>
<td>9-4</td>
</tr>
<tr>
<td>9.5</td>
<td>Using External RAM</td>
<td>9-4</td>
</tr>
<tr>
<td>9.5.1</td>
<td>RAM Recommendations</td>
<td>9-4</td>
</tr>
<tr>
<td>9.5.2</td>
<td>Address Latch</td>
<td>9-4</td>
</tr>
</tbody>
</table>
Table of Contents

9.6 Using LCD Connections.................................................................9-5
9.7 Using RS232................................................................................9-5

Section 10
In-System Programming.................................................................10-1
  10.1 ISP Lead Layout ......................................................................10-1
  10.2 ISP Header Layout.................................................................10-2
  10.3 Interface Using Resistors......................................................10-2
  10.4 Using an Analog Multiplexer IC.............................................10-2

Section 11
Technical Support...........................................................................11-1
  11.1 Contacting Atmel.................................................................11-1

Section 12
Appendix II - Warranty Statement...............................................12-1
Welcome to the STK200 Flash MCU Starter Kit. This system incorporates a sophisticated applications board, Atmel AVR® ISP software and an ISP dongle that will program any Atmel AVR microcontroller.

For up to the minute information on this product and any user guide errata, please read the AVR_ISR_REL.TEX file included with the software, or on the Atmel web site.

1.1 Device Support

The system software currently has support for the following Atmel devices.

**AVR Devices:**
- AT90S1200
- AT90S2313
- AT90S/LS2323
- AT90S/LS2343
- AT90S4414
- AT90S/LS4434
- AT90S8515
- AT90S/LS8535

Software upgrades for the AVR ISP software is posted to the AVR section of the Atmel website, which is located at http://www.atmel.com.
Section 2
Getting Started

2.1 Unpacking the System
Contents of box:
- Evaluation Board
- Disk set, including Atmel AVR ISP software
- In-System Programming (ISP) Dongle
- ISP Ribbon Cable
- AT90S8515 - 8PC Microcontroller

2.2 System Requirements
The minimum hardware and software requirements are:
- 80386 Processor (486 Recommended)
- 1MB Ram
- 1MB Free Hard Disk Space
- Windows 3.1 or Windows 95
A power supply is required with a standard 2.1mm barrel connector. It can be AC (7 - 12V) or DC (9 - 15V). The connector is inserted into the power connection socket as shown above.

The programming lead supplied is fitted into the Dongle case and the other end is inserted into the programming interface on the board as shown.

The Dongle case is connected to one of the printer ports on the PC. If this is not LPT1, then you will need to change the printer port setting in the software—see software section for details.
Connecting the Hardware
Section 4

Hardware Description

The main features of the board are shown in the following diagram.

**Note:** There are a number of jumpers on the board which are used to select different operations and voltages. The default jumper settings are for programming operations at 5V. To carry out other operations, some jumpers may have to be removed—refer to the relevant section for details. A full list of the jumpers and links are given in “Jumpers and Links and their Functions” on page 4-2.
4.1 Jumpers and Links and their Functions

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Function</th>
<th>Open</th>
<th>Closed</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>Voltage select</td>
<td>5V</td>
<td>3.3V</td>
<td>Open</td>
</tr>
<tr>
<td>JP2</td>
<td>Brown-out select</td>
<td>2.9V</td>
<td>4.5V</td>
<td>Closed</td>
</tr>
<tr>
<td>JP3</td>
<td>RS232 RXD</td>
<td>OFF</td>
<td>ON</td>
<td>Open</td>
</tr>
<tr>
<td>Port B</td>
<td>LEDs</td>
<td>LEDs Disabled</td>
<td>LEDs Enabled</td>
<td>Closed</td>
</tr>
<tr>
<td>Port D</td>
<td>Switches</td>
<td>Switches Disabled</td>
<td>Switches Enabled</td>
<td>Closed</td>
</tr>
<tr>
<td>LK1</td>
<td>Analog Reference</td>
<td>If LK1 cut then EXTERNAL REF from header</td>
<td>ONBOARD POT</td>
<td>Closed</td>
</tr>
<tr>
<td>CUT Under Board</td>
<td>LCD Contrast</td>
<td>If Cut, add extra resistor</td>
<td>Contrast Pot</td>
<td>Closed</td>
</tr>
<tr>
<td>Clock Sel</td>
<td>Selects Internal or External Clock for AT90S2323</td>
<td>INT = Internal Clock</td>
<td>EXT = External Clock</td>
<td>Closed</td>
</tr>
</tbody>
</table>

4.2 External Connections

All Ports are brought out to edge of board on to headers. Each header has a VCC and Ground pin for power supply to external circuits. Port A for A/D parts is on a separate header from Port A for standard parts, labeled “Analog”. There is an extra six-pin header for miscellaneous functions - ICP, OC1B and ALE on 40-pin Digital devices, Reset, Ground and VCC. The external load cannot exceed 100 mA for all headers combined.

See “Using External Connections” on page 9-1 and “Using Analog Parts” on page 9-3 for details.
Section 5

Installing the Software

5.1 Windows 95

To install the software, insert the supplied disk or CD-rom in your computer and perform the following steps:

1. Click on your “Start” button.
2. Select “Settings”.
3. Select “Control Panel”.
4. Choose “Add/Remove Programs”.
5. Click the “Install” button.
6. Follow on-screen prompts.

The software will then be installed onto your computer and an icon will be added to your start menu.

5.2 Windows 3.1

Choose “RUN” from Program Manager and enter “A:\SETUP.EXE” as the filename.

Press the “OK” button and the software installation program will begin.

The software will then be installed onto your computer and an icon and Program Group will be added to Program Manager.

Note: On some PCs, especially laptops, programming problems may occur if the Bios Parallel Port settings are set to EPP Version 1.7. If programming problems do happen, make sure that the Parallel Port settings in your BIOS are set to EPP V1.9 not V1.7.

In the unlikely event that you have any problems installing the software or suspect that you have faulty media, please contact the Atmel Starter Kit hotline:

Hotline Number:  (44) 1970 621 049
Fax Number:  (44) 1970 621 040
E-mail: stk200_support@atmel.com
The software is fully context-sensitive. This means that pressing F1 at any time will bring up help information about the current option that you have selected.

Please note that the toolbar icons referred to in the text have ToolTip's. If you want to know the function of any particular button, hold your mouse pointer over the button in question and its function will be displayed.

6.1 Projects

If you have used a high-end professional development system, you will be familiar with the project concept. Essentially, this is a collection of information which is managed by the program on your behalf. In the AVR you have both Program Memory and non-volatile Data Memory (EEPROM), and you have various security and device options. The project manager keeps this information together for you so you do not have to remember and reload all of the files every time you use the programmer.

It will also allow you to store information, such as the project name and the project identifier. Also included is a small notepad to store comments about the project.

Before you can start a programming session, you must either open an existing project or start a new project. You can open a project, or create a new one, by either going to the “Project” menu and selecting “New” or “Open”, or by using the “New Project” or “Open Project” buttons on the toolbar.

6.2 Files

Once a project is open, you can load the files that you want to program into the device. Files may be loaded by either using the “Load” command in the File menu or by using the “Open” icon on the toolbar.

The program will automatically decode your files whether they are in Intel Hex format, Atmel Generic, Binary, or Motorola S record. The file you choose will be loaded into the window, then will be displayed on the top of the desktop. If you have the EEPROM Data Memory window on top, then it will load the data into that window.
How to use the Software

Note that the AVR Assembler which accompanies this program will produce the correct files for you ready to load into the buffers. You can save the buffer in Binary, Intel Hex, or Atmel Generic formats, so you can use the buffer for code conversion.

Similarly, it will load the data into the Program Memory if that is the window that is on top. The program will not allow you to load data if the project manager window is on top. To change which window is on top, you can either click your mouse on any part of the window that is showing, go to the “Window” menu using Alt-W or the mouse and select the window of your choice, or press Ctrl-F6. Note that the loaded data will show up in blue text where the default, empty text color is black.

Once your data files are loaded you can start your programming session.

6.3 Editing Data

Once a project has been started, you can either load a data file or you can insert your own data in Hex or ASCII directly into the Program or EEPROM data windows.

With a new project, the data windows called buffers will contain FF in every location. This is also what a new or erased device will contain.

You can move around in the current window by using the cursor keys. In order to see memory further down the window, use the “Page Up” and “Page Down” keys on the keyboard.

You may change the data at any memory location by clicking on that location and typing in the required hex values. Any changes you make will be reflected by the data changing to green text. The ASCII character of the hex value will be shown alongside the data window.

If you wish to edit the buffer in ASCII, either click on the right area of the window or press Ctrl-A.

Once you have entered the required data, then you can save the contents of the current window by using either the “Save” icon on the toolbar or by pressing F2 (on the keyboard) or by choosing the “Save” function in the “File” menu.

6.4 Programming

Read the section on “Device Programming” on page 7-1 or “In-System Programming” on page 10-1 before programming parts.

Before you can start programming a device you must have a project open on the desktop.

6.5 Auto-Program

The easiest and quickest method of programming a device is to use the “Auto-Program” option which is available in either the “Program” menu or by using the “Auto-Program” icon on the toolbar. If you use this option, then you will be presented with a series of check boxes to select which features you want to enable or disable during the programming session. You can enable or disable any of the options by clicking on them or using “Arrow” and “Space” keys. If the option has a check mark next to it, then it is enabled, if not, then it is disabled. Note that the default is for all the options to be enabled. Further note that you should not disable the erase function under normal circumstances.

If the Dongle is not plugged into your printer port, you may get an error. If you get the “Dongle Not Found” error and it has been inserted into the printer port, make sure that you have selected the correct printer port. You can change the printer port setting by going to the “Options” menu and choosing “Change Printer Port”. Simply choose the correct one for your system.

The programmer then attempts to read the device signature bytes. If they are not found because you are using an old version of the device, no device is plugged in, the module is switched off or the lock bits are set, a message box informs you of this. You have the option of Abort, Retry or Ignore.
Auto-Program carries out all the steps you have selected. All these options are available individually in the Program Menu and some of them also have speed buttons on the toolbar.

- Erase Device
- Program Device
- Program EEPROM
- Verify Device
- Verify EEPROM
- Program Lockbits

The programmer has a dual function. In addition to being able to program a device out of circuit using the applications module, you can also program a device which has been soldered into your circuit. This allows you to solder in a blank device, program and reprogram the device without removing it from the board. See the section “In-System Programming” on page 10-1 for details. Both methods use the same user software.

6.6 New Project
This creates a new project. You will be prompted for the device type in a dialogue box. Select the device you wish to base your project around, and press the “OK” button. The system will then open Project Manager & Buffer windows to set project options and allow you to open the Program and EEPROM files.

6.7 Open Project
Open Project allows you to open an existing project, all associated files, and settings. Choose “Open Project” from the “Project” menu or use the speed button.

6.8 Save Project
It is available on the “Project” menu and the toolbar. This allows you to save your project options including font settings, window positions, and files in one quick and easy step.

You are prompted for a project file name with an .AVR extension. If either the Program or EEPROM buffers have changed, you will be prompted to save them also.

6.9 Load File
This allows you to load a data file into your project. You must have the appropriate buffer selected, Program or EEPROM on top of the desktop, when you choose “Load File” in the “File” menu or click on the “Load File” button, as the file will be loaded into the currently open buffer.

The file loader currently has support for loading the following file types:

- Binary
- Intel Hex
- Motorola S Record
- Atmel Generic

The file type is automatically selected and requires no user intervention.

6.10 Save File
This allows you to save a data file without saving the whole project. You must have the appropriate buffer selected when you select “Save File” or “Save File As”, as the file in the selected buffer will be saved.

The “Save File” option currently has support for saving the data in the following file types:
How to use the Software

- Binary
- Intel Hex
- Atmel Generic

To select the file type you want, select the file type from the “Save File as Type” pull-down box below the “File Name” list in the “Save File” dialogue box.

6.11 Exit

This will make the application close down. If you have recently made any changes to a project, you will be prompted to save your project. You can exit the program by using the speed button, clicking the “Close” icon on the program window X or choosing “Project - Exit”.

6.12 Clear Buffer

It is available on the “Buffer” menu. This will cause the currently selected buffer to be cleared i.e., filled with FF’s. Any data currently in the buffer will be lost. Only the selected buffer will be cleared.

6.13 Fill Buffer

It is available on the “Buffer” menu. A small dialogue box appears where you can select the start address “Fill From”, the end address “Fill To” and the value to insert “Fill With”. The new value is inserted in all the selected addresses and is shown as green text.

6.14 Goto

It is available on the “Buffer” menu. This will cause the cursor to move to the location in the buffer specified. If the selected value is larger than the buffer size, you are informed.

**Note:** The buffer size changes depending on the device selected.

6.15 Find

It is available on the “Buffer” menu. Find is used to search for a hex value in the buffer. Simply enter the hex value you wish to find in the small dialogue box and hit the “Find First” button. If the value is found, the cursor will move to that location and you will also notice that the “Find First” button has now changed to “Find Next”. You can use this to repeat your search and find the next occurrence. Click the mouse on “Done” or use “Tab” and “Enter” keys to close the “Find” dialogue box.

6.16 Device Empty Check

Device Empty Check is a programming function that is available on the “Program” menu. This checks to see that the device is blank, i.e., all locations contain FF.

**Note:** This function is only really useful when working with One-Time Programmable (OTP) Devices or UV Erasable Devices. It has no real use with the Atmel Flash Range, but provides a quick and easy way to check if a device is blank.

6.17 Program Device

Program Device is a programming function. It is available on the “Program” menu, or on the “Above” button on the speed bar. On the speed bar, it will program the current buffer into the appropriate memory space in the device—Code or EEPROM data depending on which window is currently “Focused”.

STK200 Starter Kit User Guide
This option programs and verifies each location from the selected buffer window into the appropriate location in the device.

**Note:** It is advisable to erase the device before programming unless you are adding extra data to existing data in the device.

If you are changing data, then you cannot change any programmed bit from a 0 to a 1 without erasing the device first. You can, however, change a bit from a 1 to a 0. For example, BB could be changed to AA but AA cannot be changed to BB. You will not be able to program the device if the write lockbit has been set.

If this function is selected from the “Program” menu, it will only program the Program Memory. In devices which also have EEPROM Memory available, you must use the “Program EEPROM” command.

The “Program Device” speed button will carry out either the “Program Memory” or “Program EEPROM” command, depending on which buffer is on top of the desktop.

---

### 6.18 Verify Device

Verify device is a programming function.

- It is available on the “Program” menu, or on the “Above” button on the speed bar.

This verifies each location in the program memory buffer window with the appropriate location in the device.

**Note:** This function will only verify the Program Memory. In devices which also have EEPROM Memory available, you must use the “Verify EEPROM” command.

The “Speed” button will either verify the program or EEPROM memory, depending on which buffer is currently selected.

---

### 6.19 Program EEPROM

Program EEPROM is a programming function.

- It is available on the “Program” menu or on the “Above” button on the speed bar. The speed button will program the current buffer into the appropriate memory space in the device, depending on which window is currently focused.

This programs and verifies each location, in the EEPROM memory buffer window into the appropriate location in the device.

**Note:** As the EEPROM features an auto-erase function, it does not require a chip-erase to be performed prior to programming. A chip-erase is only required if the lock bits are set.

The “Speed” button will either program the code or EEPROM memory, depending on which buffer is currently selected.

---

### 6.20 Verify EEPROM

Verify EEPROM is a programming function.

- It is available on the “Program” menu, or on the “Above” button on the speed bar.

This verifies each location, in the EEPROM buffer window with the appropriate location in the device.

The “Speed” button must be selected (on top) if the speed button is used.

---

### 6.21 Read Device

Read Device is a programming function.
How to use the Software

6.22 Read EEPROM

Read EEPROM is a programming function.

It is available on the “Program” menu, or on the “Above” button on the speed bar.
This will read each EEPROM location in the device into the appropriate location in the EEPROM memory buffer window.

Note: This will overwrite any existing data in the EEPROM memory buffer window.
If the speed button is used, the EEPROM data window must be on top of the desktop.

6.23 Program Lockbits

Program Lockbits is a programming function.

It is available on the “Program” menu, or on the “Above” button on the speed bar.
It will program the security lock bits according to the setting you have selected in the Project Manager.
Warning: Setting Lockbits may mean that you will be unable to perform further verification on the device and disable further writing to the device. However, you will be able to re-use the device if you perform an erase.

6.24 Erase Device

Erase Device is a programming function.

It is available on the “Program” menu, or on the “Above” button on the speed bar.
This will erase all data from the Program Memory and EEPROM Memory, if available, on the device.
It is advisable to always erase a device before programming.
Warning: Erasing a device will clear all data from the device permanently.

6.25 Health Check

Health Check is a programming function.
This unique function will check the device to see if it has any defects, which may prevent it from programming correctly. For example, you can use it to test an old device to see if it still works. This function also has an associated button on the toolbar. Note that this function will erase any data that is currently on the device.
It will report a Pass or Failure.

6.26 Printer Port

This allows you to set which printer port the programmer is currently connected to.
Simply select the appropriate printer port and press the “Change” button.
To cancel any changes you have made, press the “Cancel” button.
6.27 Font Selection
This allows you to set a different font for the Buffer Windows. You may wish to do this if the default font is too small or unclear. The default font is Terminal, size 10, which is set for 14-inch monitors. The default font is probably too small for larger monitors.
As a rule of thumb, Terminal font is usually best for displaying the full ASCII character set, as it has all the characters below 20. You will find other fonts will “fill” these characters with a circumflexed Y or another similar character.

6.28 Advanced Options
This allows you to override “Signature Byte Checking”.
This is useful if you use a lot of pre-production devices which may not have signature information included or you are using an unsupported device which has the same programming algorithm. Use with care.

6.29 Edit as ASCII
This option allows you to change the editing mode from Hex to ASCII and back. This is useful if a mouse or pointing device is not available.

6.30 Device Checksum
 Reads device and calculates the check sum. It does not load the buffer with the device contents.

6.31 Select Colors
This allows you to change the color of the text in the buffer windows.
The 5 text modes and their default colors are:

<table>
<thead>
<tr>
<th>Text Mode</th>
<th>Default Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Black</td>
</tr>
<tr>
<td>Load Data</td>
<td>Blue</td>
</tr>
<tr>
<td>Edited Data</td>
<td>Blue</td>
</tr>
<tr>
<td>Verified Data</td>
<td>Green</td>
</tr>
<tr>
<td>Program/Verify failure</td>
<td>Red</td>
</tr>
</tbody>
</table>

The default colors can be changed selecting the data type you wish to change in the “Data Type” list, and clicking on the “Change Color” button.
7.1 Device Orientation

Before programming a device using the programming module, the device must be inserted correctly into the programming unit. The AVR device has an arrow printed on it, which points towards pin 1 of the device. Below are the four socket types and their orientation.

**8-Pin Devices**

**20-Pin Devices**

**28-Pin Devices**

**40-Pin Devices**

Another method of checking to see if it is inserted correctly is to check the notches on both the device and the programming socket. At the end of the device you will notice a notch cut-out. There is a notch cut-out on the device socket which is also printed on the board. The notch on the device must correspond with the notch in the socket.

The orientation of the device is vitally important. If you put it in the wrong way then you may damage the device. **Do not plug a device in with the power switched on** or you may damage it. Similarly, never remove the device with the power on.
40-pin A/D parts have different pinouts from the digital only 40-pin parts. Make sure you have inserted your device in the correct 40-pin socket on the board. The board has “A/D” and “Digital” written inside the sockets.

**Note:** Do not insert a device in more than one socket at a time otherwise programming errors will occur.

### 7.2 Voltage Selection

Jumper JP1 is used to select either 3.3V or 5V programming.
- For $V_{CC} = 5V$, remove jumper JP1 — jumper open
- For $V_{CC} = 3.3V$, insert JP1 — jumper closed

Jumper JP2 is used to set Brown-Out detector voltage.
- For Brown-Out = 5V, insert jumper JP2 — jumper closed
- For Brown-Out = 3.3V, remove jumper JP2 — jumper open

This should be set to the same voltage as $V_{CC}$. If $V_{CC}$ is set to 3.3V and Brown-Out is set to 5V, then the device will be held in reset and will **not** program. See the section “Brown-Out Detector” on page 8-1 for more details.

![Jumper Diagram](image)

### 7.3 Power and Lead Connections

The 10-way programming lead is inserted in the box header—the key-way ensures correct orientation. The computer connections are shown in the section “Connecting the Hardware” on page 3-1.

The power supply 9-15V DC or 7-12V AC is plugged into the power connector 5.5/2.1 Barrel.

The “Power On/Off” switch is located next to the power connector. Insert the device before switching the power on. The power on LED should light when the power is correctly applied.

Your hardware is now ready for programming. Refer to “How to use the Software” on page 6-1 for details of programming operations.

### 7.4 Programming 8-Pin Parts

As these parts are only 8-pin, the clock inputs use two of the port pins. These pins can be used as port pins on some devices if the device is set to run on internal clock. The internal clock is set by programming a fuse but this may not be set on new parts, so a jumper is supplied to enable the device to be programmed with external clock.

We recommend that the jumper labeled “Clock Sel” is set to “EXT” when programming new parts. The fuse setting can then be read and set to internal clock if the port pins are required, and the jumper setting can then be changed to “INT” for internal clock operation.

**Note:** If the internal clock fuse is set, the internal clock will operate even if an external clock is supplied.

If difficulties are found in programming these parts, remove the jumper set labeled “Port B”. (Bits 0 to 2 are the programming lines.)
Section 8
Brown-Out Detector

The brown-out detector circuit is used to detect voltage drops. If a short glitch occurs in the power, this circuit ensures that the processor resets properly rather than operating randomly.

The brown-out detector must be set to the same voltage as the circuit voltage, $V_{CC}$—3.3V or 5V. For 3.3V operation, jumper JP2 must be removed (jumper open) and for 5V operation it must be closed.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Operating Voltage</th>
<th>Hysteresis</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 Volts</td>
<td>4.5 Volts</td>
<td>200 mV</td>
</tr>
<tr>
<td>3.3 Volts</td>
<td>2.9 Volts</td>
<td>200 mV</td>
</tr>
</tbody>
</table>

These values are approximate and may vary with temperature and other factors.

If the brown-out detector voltage is set to 5V and $V_{CC}$ is set to 3.3V, then the brown-out circuit will operate continuously and the device will be held in permanent reset. JP1 and JP2 must be set to the same voltage, which is always 1 open and 1 closed.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>JP1</th>
<th>JP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 Volts</td>
<td>Open</td>
<td>Closed</td>
</tr>
<tr>
<td>3.3 Volts</td>
<td>Closed</td>
<td>Open</td>
</tr>
</tbody>
</table>
9.1 Using Switches and LEDs

The LEDs are connected through a 1K resistor network to Port B.
The switches are connected to Port D.
The switches and LEDs can be disconnected, if required. To use them, ensure that the jumpers labeled Port B and Port D are closed. The board is also marked with the port pin connection for each switch and LED.

9.1.1 Using 8-Pin Devices with LEDs

The port pins on the AT90S2323 and other 8-pin parts are not connected to the correctly labeled LEDs due to layout constraints. The actual connections are shown in the table below:

<table>
<thead>
<tr>
<th>Processor Pin</th>
<th>LED Label</th>
<th>Socket Pin Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PB0</td>
<td>PB5</td>
<td>5</td>
</tr>
<tr>
<td>PB1</td>
<td>PB6</td>
<td>6</td>
</tr>
<tr>
<td>PB2</td>
<td>PB7</td>
<td>7</td>
</tr>
<tr>
<td>PB3</td>
<td>PB3</td>
<td>2</td>
</tr>
<tr>
<td>PB4</td>
<td>PB4</td>
<td>3</td>
</tr>
</tbody>
</table>

9.2 Configuring switches and LEDs

The ports must be correctly set in software as input or output. This is accomplished by setting the direction control registers to 0 for input and 1 for output. Typical set-up code would be:

1. `ldi r16,$ff` ;load immediate into temp storage register
2. `out DDRB,r16` ;PORTB (LED’s) is all outputs
3. `ldi r16,$00` ;load immediate into temp storage register
4. `out PORTB,r16` ;switch all the LEDs on
5. `out DDRD,r16` ;set direction register to zeros for input

9.3 Using External Connections

All the ports are brought out to headers on the edge of the board but there are differences for different sockets which are described separately. Port B has current limit resistors for programming on Pin 7, Pin 6 and Pin 5 MOSI, MISO and SCK. These port pins will only supply a reduced current if used as outputs—300 micro Amps @ 3.3V and 500 micro Amps @ 5V. As inputs, they will behave normally. Therefore, any user circuit should use Port B for inputs.
Board Applications

- 28-pin socket – Analog parts. This is connected differently and is described separately below.

- 40-pin socket – A/D Parts. Port A is connected to header marked “Analog”, not the header labeled “Port A”. Port B, Port C and Port D are the same as the 40-pin digital socket.

- 40-pin socket – Digital Parts. This is connected to headers marked “Port A”, “Port B”, “Port C” and “Port D”.

- 20-pin socket. Port B and Port D are connected to headers marked “Port B” and “Port D”.

- 8-pin socket – This is connected to Port B with a slightly different layout and is described separately below.

In addition to the port pins, each header has a connection for ground and $V_{CC}$ to supply external circuits. This voltage $V_{CC}$ will be either 3.3V or 5V depending on the setting of jumper 1 JP1 and the brown-out detector will operate as normal (see “Brown-Out Detector” on page 8-1).

**Note:** If your circuit is to draw significant current >250 mA then a heat sink will be required on the on-board regulator—LM317. This device is rated at 1.5 Amps but it needs a heat sink to supply this current. If your circuit will draw more than 1 Amp, you may need a separate power supply.

**9.3.1 20-Pin and 40-Pin Digital Sockets**

The ports on the 40-pin digital socket are connected to the headers marked “Port A”, “Port B”, “Port C” and “Port D”. The 20-pin socket is connected to the headers marked “Port B” and “Port D”. The layout of all the headers is the same and is shown in the following diagram.

**9.3.2 40-Pin A/D Socket**

The layout, shown above, applies to Port B, Port C and Port D on these parts. Port A is the Analog input port on these devices and is connected to the header marked “Analog”, NOT Port A. The layout of this header and how to use the A/D functions is described in the section “Using Analog Parts” on page 9-3.

**9.3.3 28-Pin Socket**

This socket is also for A/D parts. There are three ports on this device—Port B, Port C and Port D.

Port C is the Analog input port and it is connected to the header marked “Analog” NOT Port C. See the section on “Using Analog Parts” on page 9-3 for details.

Port D is connected as normal—see diagram above.
Port B only has six bits, PB0 - PB5, but these are connected to bits 2 to 7 on the header to match the functionality of the other devices. This is shown in the diagram below.

9.3.4 8-Pin Socket

The 8-Pin socket has five Port bits connected: PB0 - PB4. These are connected to the header marked “Port B”, but they are not connected to the headers in the same way as the other sockets. The connections for this socket on the Port B header are shown below:

9.3.5 Misc. Header

The last header labelled “Misc.” has connections to processor pins other than the port pins, especially for the AT90S8515 and AT90S4414. The layout of this header is:

9.3.6 All Sockets

If external operations do not want pull-ups on the port pin, both the switches and the LEDs can be disconnected from the processor. To isolate the LEDs, remove the jumper set labeled “Port B”. To isolate the switches, remove the jumper set labeled “Port D”.

9.4 Using Analog Parts

40-pin Analog parts must be used in the socket marked “A/D parts”, and 28-pin parts must be used in the socket marked “28-Pin”. The A/D converters use the header labeled “Analog” for the A/D inputs. This header is connected to Port A on the 40-pin A/D socket and Port C on the 28-pin socket. The layout of this header is shown on the following page.
Analog Port: Marked on Board

The A/D converters can use either the on-board (Internal) Voltage Reference or an external Voltage Reference.

9.4.1 Using Internal Reference

To use the internal on-board Voltage Reference, the pot marked “AREF” is used to set the voltage level. The voltage level can be measured with a meter connected to the header pins labeled “Analog Ref” and “Analog Gnd” in the above diagram or from the two holes marked “Meter +” and “Meter -”.

9.4.2 Using External Reference

To use the A/D converters with an external Voltage Reference, the link marked “LK1” must be cut. The voltage is applied to the pins marked “Analog Ref” and “Analog Gnd” on the Analog header—see diagram above.

9.5 Using External RAM

The AT90S8515 and AT90S4414 can be used with external SRAM. A socket is provided for a 28-pin RAM chip and for an address latch chip. These are next to the Atmel logo on the board.

9.5.1 RAM Recommendations

A low-power 62256 SRAM is suggested with an access time of 70 ns. If a very fast RAM is required, the crystal frequency may need to be increased. If a much slower SRAM is used, the SRAM Wait State bit must be enabled in user software—see data book. The layout of the 28-pin RAM socket is shown below, and any RAM with this pin-out could be used.

**RAM Socket pin layout**

9.5.2 Address Latch

The board connections are for a 74HC573 device. This device will operate reliably with the 4 MHz crystal supplied but if a faster crystal is inserted, a faster version of this device may be required—74AHC573 or 74FHC573. Note that this option will alter the EMC characteristics of the board and the CE mark will no longer be valid without retesting.
9.6 Using LCD
Connections

The header marked LCD next to the 28-pin socket, is for a standard 2 x 16 LCD. The connections are shown on the board and in the following table.

<table>
<thead>
<tr>
<th>Connection Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>0V</td>
<td>Ground</td>
</tr>
<tr>
<td>+5</td>
<td>$V_{CC}$ - must be 5V</td>
</tr>
<tr>
<td>Vo</td>
<td>Contrast</td>
</tr>
<tr>
<td>RS</td>
<td>Register Select- A14</td>
</tr>
<tr>
<td>Wr</td>
<td>Not Write</td>
</tr>
<tr>
<td>E</td>
<td>Enable</td>
</tr>
<tr>
<td>D0</td>
<td>Data Bit 0</td>
</tr>
<tr>
<td>D1</td>
<td>Data Bit 1</td>
</tr>
<tr>
<td>D2</td>
<td>Data Bit 2</td>
</tr>
<tr>
<td>D3</td>
<td>Data Bit 3</td>
</tr>
<tr>
<td>D4</td>
<td>Data Bit 4</td>
</tr>
<tr>
<td>D5</td>
<td>Data Bit 5</td>
</tr>
<tr>
<td>D6</td>
<td>Data Bit 6</td>
</tr>
<tr>
<td>D7</td>
<td>Data Bit 7</td>
</tr>
</tbody>
</table>

The board is designed for use with a LCD with a Hitachi driver chip built-in, using a contrast pin voltage of 0 to 5 Volts. The pot next to the LCD connector, not marked AREF, is used for contrast adjustment.

If you use a different LCD driver, it may have a different voltage contrast range. In order to accommodate this, add a resistor to the board, and cut track on underside of board—marked cut. See diagram above.

This board is not designed for use with back lit LCD modules, so the extra connections needed are not included and the power supply will not supply the current required.

The LCD can be driven in Memory Mapped or I/O Mode—see data sheet. If the crystal has been changed to a faster crystal frequency, memory mapped operations will not work.

9.7 Using RS232

The connection supplied is a 9-way female D-type, therefore, a “straight through” lead is required—not a null-modem cable.

Jumper JP3 must be closed or RXD will be disabled. RXD and TXD are on pins PD0 and PD1. It is recommended that these switches are disconnected by removing the
jumpers labeled Port D. JP2 is the Brown-Out voltage jumper—ensure that this is set to 3.3 or 5 Volts as required.

As this board has a 4 MHz crystal, the percentage error on the Baud Rate will be between 0.2% and 7.8%. Replacing the crystal with a 3.6846 MHz or 4.608 MHz crystal will reduce this error to zero but may have EMC implications.

A standard (straight through) lead is required, **not** a null-modem cable.
Section 10

In-System Programming

Devices can be programmed in your circuit rather than on the board using the STK200 ISP dongle that was included in the kit. The dongle works with a 0.1” pitch header that is mounted on your application board.

You will need to use either a multiplexer chip (such as a 4053), or wire directly to the pins of the device. The pins on the device are connected as follows:

<table>
<thead>
<tr>
<th>AVR Device</th>
<th>1200</th>
<th>2313</th>
<th>2323/2343</th>
<th>4414</th>
<th>8515</th>
<th>8535/4434</th>
<th>MEGA603/MEGA103</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Pin1</td>
<td>Pin1</td>
<td>Pin1</td>
<td>Pin9</td>
<td>Pin9</td>
<td>Pin9</td>
<td>Pin20</td>
</tr>
<tr>
<td>MOSI (PDI)</td>
<td>PB5</td>
<td>PB5</td>
<td>PB0</td>
<td>PB5</td>
<td>PB5</td>
<td>PB5</td>
<td>PB5</td>
</tr>
<tr>
<td></td>
<td>Pin17</td>
<td>Pin17</td>
<td>Pin5</td>
<td>Pin6</td>
<td>Pin6</td>
<td>Pin6</td>
<td>PE0</td>
</tr>
<tr>
<td>MISO (PDO)</td>
<td>PB6</td>
<td>PB6</td>
<td>PB1</td>
<td>PB6</td>
<td>PB6</td>
<td>PB6</td>
<td>PB6</td>
</tr>
<tr>
<td></td>
<td>Pin18</td>
<td>Pin18</td>
<td>Pin6</td>
<td>Pin7</td>
<td>Pin7</td>
<td>Pin7</td>
<td>PE1</td>
</tr>
<tr>
<td>SCK</td>
<td>PB7</td>
<td>PB7</td>
<td>PB2</td>
<td>PB7</td>
<td>PB7</td>
<td>PB7</td>
<td>PB7</td>
</tr>
<tr>
<td></td>
<td>Pin19</td>
<td>Pin19</td>
<td>Pin7</td>
<td>Pin8</td>
<td>Pin8</td>
<td>Pin8</td>
<td>PB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Pin11</td>
</tr>
</tbody>
</table>

In addition, the system +5 Volts and Ground need to be connected to the programming lead.

Do not exceed 5 volts or you may damage your computer. 4.75 to 5.25 volts is allowed. This warning applies to any ISP system.

10.1 ISP Lead Layout

Note: This is a face view of the ISP lead. Section 10.2 shows connector on user circuit.
10.2 ISP Header Layout

Note: This is a view of the header needed on user circuit, not a face view of ISP lead.

10.3 Interface Using Resistors

Typical resistor values would be 1K. This circuit is fine if ports PB7, PB6 and PB5 are used as inputs in your circuit. If outputs are needed, especially higher than a few milliamps, then the multiplexed circuit is preferable.

10.4 Using an Analog Multiplexer IC

The multiplexer select can be driven from the LED connection on the programming lead as can a low-power LED with its cathode connected to the LED connection via a suitable resistor—1KΩ is fine. If you use this connection, then the output will be low 0 during programming and a 1 at all other times. Note that it will float if the programmer is not active, i.e., the software is not running so you may need to use a pull-up resistor.

All the pins, except ground, will float if the programmer is not active. The device may then be programmed in the normal way.
Section 11

Technical Support

Technical support for this product is provided by the AVR Starter Kit Support Team. Contact information is provided below.

11.1 Contacting Atmel

We would be grateful if you can report any errors you may find in this software. We pride ourselves on our customer support. As soon as we are aware of the problem, we can solve it and send you an update very quickly via e-mail. If you wish to communicate via telephone, the number is listed below:

Tel: (44) 1970 621 049 STK200 Technical Support Hotline
Fax: (44) 1970 621 040

E-mail: stk200_support@atmel.com
Website: www.atmel.com

We also have an extensive range of AVR development products available. Please visit our website (http://www.atmel.com) for full details.

Software upgrades will be made available on our website.
Atmel warrants that the Product delivered hereunder shall conform to the applicable Atmel Data Sheet or mutually agreed upon specifications and shall be free from defects in material and workmanship under normal use and service for a period of 30 days from the applicable date of invoice. Products which are “samples”, “design verification units”, and/or “prototypes” are sold “AS IS,” “WITH ALL FAULTS,” and without a warranty.

If, during such warranty period, (i) Atmel is notified promptly in writing upon discovery of any defect in the goods, including a detailed description of such defect; (ii) such goods are returned to Atmel, DDP Atmel’s facility accompanied by Atmel’s Returned Material Authorization form; and (iii) Atmel’s examination of such goods discloses to Atmel’s satisfaction that such goods are defective and such defects are not caused by accident, abuse, misuse, neglect, alteration, improper installation, repair, improper testing, or use contrary to any instructions issued by Atmel, Atmel shall (at its sole option) either repair, replace, or credit Buyer the purchase price of such goods. No goods may be returned to Atmel without Atmel’s Returned Material Authorization form.

Prior to any return of goods by Buyer pursuant to this Section, Buyer shall afford Atmel the opportunity to inspect such goods at Buyer’s location, and any such goods so inspected shall not be returned to Atmel without its prior written consent.

Atmel shall return any goods repaired or replaced under this warranty to Buyer transportation prepaid, and reimburse Buyer for the transportation charges paid by Buyer for such goods. The performance of this warranty does not extend the warranty period for any goods beyond that period applicable to the goods originally delivered.

THE FOREGOING WARRANTY CONSTITUTES ATMEL’S EXCLUSIVE LIABILITY, AND THE EXCLUSIVE REMEDY OF BUYER, FOR ANY BREACH OF ANY WARRANTY OR OTHER NONCONFORMITY OF THE GOODS COVERED BY THIS AGREEMENT. THIS WARRANTY IS EXCLUSIVE, AND IN LIEU OF ALL OTHER WARRANTIES. ATMEL MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING WITHOUT LIMITATION ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. THE SOLE AND EXCLUSIVE REMEDY FOR ANY BREACH OF THIS WARRANTY SHALL BE AS EXPRESSLY PROVIDED HEREIN.

Limitation on Liability
Notwithstanding anything to the contrary contained herein, Atmel shall not, under any circumstances, be liable to Buyer or any third parties for consequential, incidental, indirect, exemplary, special, or other damages. Atmel’s total liability shall not exceed the total amount paid by Buyer to Atmel hereunder. Atmel shall not under any circumstances be liable for excess costs of reprocurement.